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1. PREFACE 
 

1.1. INTRODUCTION TO THE XPOSITION 
 

This manual describes the installation, operation, and diagnostics of the Aparian XPosition 

Module. The XPosition Module provides an interface to high accuracy positioning equipment 

which can be used across a range of position sensitive applications. 

 

 
 

Figure 1.1. ς Typical architecture using the Trimble BX982 
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1.2. FEATURES 
 

The XPosition module provides a method for connecting high precision GPS and inertial 

navigation ŘŜǾƛŎŜǎ ǘƻ wƻŎƪǿŜƭƭ !ǳǘƻƳŀǘƛƻƴΩǎ [ƻƎƛȄ (ControlLogix and CompactLogix) family of 

controllers. Any third party Device can be interfaced to, provided it supports NMEA 0183 

communications over Ethernet. 

 

The XPosition module is configured using the Aparian Slate application. This program can be 

downloaded from www.aparian.com free of charge. Slate offers various configuration 

methods. 

 

Hereafter the XPosition module will be referred to as the XPosition. 

 

The XPosition operates in ŀ [ƻƎƛȄ άƻǿƴŜŘέ ƳƻŘŜΦ ²ƛǘƘ ŀ [ƻƎƛȄ ŎƻƴƴŜŎǘƛƻƴ ǘƘŜ ƛƴǇǳǘ ŀƴŘ 

output assemblies will provide position and diagnostics information which will be available in 

the Logix controller environment.  

 

The XPosition also supports Modbus Holding registers allowing the user to access the 

XPosition with Modbus TCP. 

 

The XPosition uses an external GPS receiver to provide accurate position information. The 

external GPS or inertial navigation device provides various accuracy estimates allowing the 

user to make informed decisions for high precision position and velocity applications.  

 

The XPosition can also be interfaced with dual antenna receivers and in so doing provide the 

additional Yaw, Tilt and Heading data. 

 

A built-in webserver provides detailed diagnostics of system configuration and operation, 

including the display of GPS time, position, and velocity without the need for any additional 

software.  

 

http://www.aparian.com/
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1.3. ARCHITECTURE 
 

The figure below provides an example of the typical network setup.  

 

 
 

Figure 1.2. - Example of a typical network setup 

 

The XPosition module will convert the data received from the high precision device (e.g. 

Trimble BX982) in order for the Logix controller to use it. The XPosition can also connect to 

the Logix controller or Precision GPS / Inertial navigation device over wireless networks 

allowing the user to accurately measure position of mobile applications (e.g. Cranes, Stackers, 

etc.). 
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Figure 1.3. - Example of a wireless network setup 

 

 

 
  

Figure 1.3. ς Stacker / Reclaimer Example  
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1.4. ADDITIONAL INFORMATION 
 

The following documents contain additional information that can assist the user with the 

module installation and operation. 

 

Resource Link 

Slate Installation http://www.aparian.com/software/slate 

XPosition User Manual 
XPosition Datasheet 
Example Code & UDTs 

http://www.aparian.com/products/xposition 

Ethernet wiring standard 
www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/
guide/cde205_220_420_hig/Connectors.html 

Trimble precision devices http://www.trimble.com/tsg/precision-gnss.aspx  

 

Table 1.1. - Additional Information 

 

 

1.5. SUPPORT 
 

Technical support is provided via the Web (in the form of user manuals, FAQ, datasheets etc.) 

to assist with installation, operation, and diagnostics.  

 

For additional support the user can use either of the following: 

 

Resource Link 

Contact Us web link https://www.prosoft-technology.com/Services-Support/Customer-Support 

Support email support@prosoft-technology.com 

 

Table 1.2. ς Support Details   

http://www.aparian.com/software/slate
http://www.aparian.com/products/xposition
http://www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guide/cde205_220_420_hig/Connectors.html
http://www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guide/cde205_220_420_hig/Connectors.html
http://www.trimble.com/tsg/precision-gnss.aspx
https://www.prosoft-technology.com/Services-Support/Customer-Support
mailto:support@prosoft-technology.com
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2. INSTALLATION 
 

2.1. MODULE LAYOUT 
 

The module has three ports at the bottom of the enclosure as shown in the figure below. The 

ports are used for Ethernet, RS232 serial, and power. The power port uses a three way 

connector which is used for the DC power supply and the earth connection. 

 

NOTE: The RS232 for this module is reserved and should not be used.  

 

 

The Ethernet cable must be wired according to industry standards which can be found in the 

additional information section of this document. 

 

 

 
 

Figure 2.1. - XPosition side and bottom view 

 

 

The module provides three diagnostic LEDs as shown in the front view figure below. These 

LEDs are used to provide information regarding the module system operation, the Ethernet 

interface, and the external device communication. 
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Figure 2.2. ς XPosition front and top view 

 

The module provides four DIP switches at the top of the enclosure as shown in the top view 

figure above.  

 

DIP Switch Description 

DIP Switch 1 ¦ǎŜŘ ǘƻ ŦƻǊŎŜ ǘƘŜ ƳƻŘǳƭŜ ƛƴǘƻ ά{ŀŦŜ aƻŘŜέΦ ²ƘŜƴ ƛƴ ά{ŀŦŜ aƻŘŜέ ǘƘŜ ƳƻŘǳƭŜ ǿƛƭƭ ƴƻǘ 
load the application firmware and will wait for new firmware to be downloaded. This 
should only be used in the rare occasion when a firmware update was interrupted at 
a critical stage.  

DIP Switch 2 This will force the module into DHCP mode which is useful when the user has forgotten 
the IP address of the module. 

DIP Switch 3 Reserved 

DIP Switch 4 When this DIP Switch is set at bootup it will force the module Ethernet IP address to 
192.168.1.100 and network mask 255.255.255.0. The user can then switch the DIP 
switch off and assign the module a static IP address if needed. 

 

Table 2.1. - DIP Switch Settings 
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2.2. MODULE MOUNTING 
 

NOTE: This module is an open-type device and is meant to be installed in an 

enclosure suitable for the environment such that the equipment is only accessible 

with the use of a tool. 

 

The module provides a DIN rail clip to mount onto a 35mm DIN rail.  

 

 
Figure 2.3 - DIN rail specification 

 

The DIN rail clip is mounted on the bottom of the module at the back as shown in the figure 

below. Use a flat screw driver to pull the clip downward. This will enable the user to mount 

the module onto the DIN rail. Once the module is mounted onto the DIN rail the clip must be 

pushed upwards to lock the module onto the DIN rail. 

 

 
 

Figure 2.4 - DIN rail mouting 
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2.3. POWER 
 

A three-way power connector is used to connect Power+, Powerς (GND), and earth. The 

module requires an input voltage of 10 ς 28Vdc. Refer to the technical specifications section 

in this document.  

 

 
Figure 2.5 - Power connector 

 

2.4. ETHERNET PORT 
 

The Ethernet connector should be wired according to industry standards. Refer to the 

additional information section in this document for further details. 
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3. SETUP 
 

3.1. INSTALL CONFIGURATION SOFTWARE 
 

All the network setup and configuration of the module is achieved by means of the Aparian 

Slate device configuration environment. This software can be downloaded from 

http://www.aparian.com/software/slate. 

 

 
Figure 3.1. - Aparian Slate Environment 

   

3.2. NETWORK PARAMETERS 
 

The module will have DHCP (Dynamic Host Configuration Protocol) enabled as factory default. 

Thus a DHCP server must be used to provide the module with the required network 

parameters (IP address, subnet mask, etc.). There are a number of DHCP utilities available, 

however it is recommended that the DHCP server in Slate be used. 

 

Within the Slate environment, the DHCP server can be found under the Tools menu. 

 

 
 

Figure 3.2. - Selecting DHCP Server 

  

http://www.aparian.com/software/slate
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Once opened, the DHCP server will listen on all available network adapters for DHCP requests 

and display their corresponding MAC addresses. 

 

 
Figure 3.3. - DHCP Server 

 

NOTE: If the DHCP requests are not displayed in the DHCP Server it may be due 

ǘƻ ǘƘŜ ƭƻŎŀƭ t/Ωǎ ŦƛǊŜǿŀƭƭΦ 5ǳǊƛƴƎ ƛƴǎǘŀƭƭŀǘƛƻƴ ǘƘŜ ƴŜŎŜǎǎŀǊȅ ŦƛǊŜǿŀƭƭ ǊǳƭŜǎ ŀǊŜ 

automatically created for the Windows firewall. 

Another possibility is that another DHCP Server is operational on the network 

and it has assigned the IP address. 

 

¢ƻ ŀǎǎƛƎƴ ŀƴ Lt ŀŘŘǊŜǎǎΣ ŎƭƛŎƪ ƻƴ ǘƘŜ ŎƻǊǊŜǎǇƻƴŘƛƴƎ ά!ǎǎƛƎƴέ ōǳǘǘƻƴΦ ¢ƘŜ Lt !ŘŘǊŜǎǎ 

Assignment window will open. 

 

 
Figure 3.4. - Assigning IP Address 

  

The required IP address can then be either entered, or a recently used IP address can be 

selected by clicking on an item in the Recent List. 

 

LŦ ǘƘŜ ά9ƴŀōƭŜ {ǘŀǘƛŎέ ŎƘŜŎƪōƻȄ ƛǎ ŎƘŜŎƪŜŘΣ ǘƘŜƴ ǘƘŜ Lt ŀŘŘǊŜǎǎ ǿƛƭƭ ōŜ ǎŜǘ ǘƻ ǎǘŀǘƛŎ ŀŦǘŜǊ ǘƘŜ Lt 

assignment, thereby disabling future DHCP requests. 

 

Once the IP address window has been accepted, the DHCP server will automatically assign the 

IP address to the module and then read the Identity object Product name from the device.  
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The successful assignment of the IP address by the device is indicated by the green 

background of the associated row. 

 

 
 

Figure 3.5. - Successful IP address assignment 

 

It is possible to force the module back into DHCP mode by powering up the device with DIP 

switch 2 set to the On position.  

 

A new IP address can then be assigned by repeating the previous steps.  

 

NOTE: It is important to return DIP switch 2 back to Off position, to avoid the 

module returning to a DHCP mode after the power is cycled again. 

 

LŦ ǘƘŜ ƳƻŘǳƭŜΩǎ 5Lt ǎǿƛǘŎƘ 2 is in the On position during the address assignment, the user will 

be warned by the following message. 

 

 
Figure 3.6. - Force DHCP warning 

 

In addition to the setting the IP address, a number of other network parameters can be set 

during the DHCP ǇǊƻŎŜǎǎΦ ¢ƘŜǎŜ ǎŜǘǘƛƴƎǎ Ŏŀƴ ōŜ ǾƛŜǿŜŘ ŀƴŘ ŜŘƛǘŜŘ ƛƴ {ƭŀǘŜΩǎ !ǇǇƭƛŎŀǘƛƻƴ 

Settings, in the DHCP Server tab. 

 

Once the DHCP process has been completed, the network settings can be set using the 

Ethernet Port Configuration via the Target Browser. 

 

The Target Browser can be accessed under the Tools menu. 
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Figure 3.7. - Selecting the Target Browser 

 

The Target Browser automatically scans the Ethernet network for EtherNet/IP devices. 

 

 
Figure 3.8. - Target Browser 

 

Right-clicking on a device, reveals the context menu, including the Port Configuration option. 

 

 
 

Figure 3.9. - Selecting Port Configuration  
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All the relevant Ethernet port configuration parameters can be modified using the Port 

Configuration window. 

 

 
 

Figure 3.10. - Port Configuration 

 

Alternatively, these parameters can be modified using Rockwell AutomationΩǎ RSLinx 

software. 
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3.3. CREATING A NEW PROJECT 
 

Before the user can configure the module, a new Slate project must be created. Under the 

File menu, select New. 

 

 
Figure 3.11. - Creating a new project 

 

A Slate project will be created, showing the Project Explorer tree view. To save the project 

use the Save option under the File menu. 

 

A new device can now be added by selecting Add under the Device menu. 

 

 
 

Figure 3.12. - Adding a new device 

 

 

 In the Add New Device window select the XPosition, and click the Ok button.  
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Figure 3.13 ς Selecting a new XPosition 

 

The device will appear in the Project Explorer tree as shown below, and its configuration 

window opened.  

 

The device configuration window can be reopened by either double clicking the module in 

the Project Explorer tree or right-clicking the module and selecting Configuration. 

 

 
 

Figure 3.14. ς XPosition configuration 

 

Refer to the additional information section in this document for SlateΩǎ ƛƴǎǘŀƭƭŀǘƛƻƴ ŀƴŘ 

operation documentation. 
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3.4. XPOSITION PARAMETERS 
 

The XPosition parameters will be configured by Slate. Refer to the additional information 

section for documentation and installation links for Aparian Slate. The XPosition parameter 

configuration consists of a general configuration as well as an external Ethernet GPS receiver. 

When downloading this configuration into the module it will be saved in non-volatile memory 

that persists when the module is powered down.  

 

NOTE: When a firmware upgrade is performed the module will clear all 

XPosition configuration and routing maps.  

 

The general configuration consists of the following parameters: 

 

Parameter Description 

Instance Name This parameter is a user defined name to identify between various XPosition modules. 

Description This parameter is used to provide a more detail description of the application for the 
module.  

IP Address The IP address of the target module 

Major Revision The major revision of the module 

 

Table 3.1 - General configuration parameters 

 

The general configuration is shown in the figure below. The XPosition general configuration 

window is opened by either double clicking on the module in the tree or right-clicking the 

module and selecting Configuration. 

 

 
Figure 3.15. - General Configuration 
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The External GPS configuration consists of the following parameters: 

 

Parameter Description 

IP Address This is the IP address of the external GPS receiver that will be communicated to. 

TCP Port This is the TCP port of the external GPS receiver that will be used for the NMEA 
communication. 

Connection Timeout This is the amount of time in milliseconds the XPosition will wait for a packet from 
the NMEA device before restarting the connection. 

 

Table 3.2 ς External GPS configuration parameters 

 

The external GPS configuration is shown in the figure below.  

 

 
 

Figure 3.16 ς External GPS configuration 
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3.5. TRIMBLE BX982 
 

The Trimble BX982 is high precision GPS receiver which communicates over Ethernet using 

various protocols. The BX982 will need to be configured to communicate with the XPosition 

module using NMEA over Ethernet. The user must also ensure that the IP address and TCP 

port selected in the XPosition configuration is the same as that of the BX982. The BX982 is 

configured through the device webserver. Refer to the documentation for details how to 

access the webserver and login details (see section 1.4). Once the user has connected to the 

BX982 via the webserver the IO configuration will need to be set by clicking Port Configuration 

under the I/O configuration as shown below: 

 

 
 

Figure 3.17 ς BX982: Select port configuration 

 

Next a TCP/IP port will need to be configured. This is done by clicking on one of the ports as 

shown below: 

 

 
 

Figure 3.18 ς BX982: Select TCP/IP port 
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The user will need to configure the protocol for the TCP/IP port as NMEA by selecting it from 

the drop-down box as shown below: 

 

 
 

Figure 3.19 ς BX982: Select NMEA protocol 

 

The TCP port and IP address (as shown below) must be setup to match the TCP port selected 

in the XPosition configuration as described in section 3.4.  

 

NOTE: If either the TCP port or IP address configured for the XPosition does 

not match that of the BX982 no connection will be established and the 

XPosition will not operate correctly.  
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Figure 3.20 ς BX982: Select TCP port 

 

Once NMEA has been selected the user will need to select the relevant messages that the 

BX982 will need to output. The following will need to be selected; AVR, BPQ, GGA, GSA, GST, 

GSV, HDT, RMC, ROT, VTG, and ZDA. This is shown below: 
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Figure 3.21 ς BX982: Select NMEA output messages 

 

Once done the configured port will listen for a connection request from the XPosition as 

shown below: 
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Figure 3.22 ς BX982: Configured TCP/IP port 

Once the XPosition has established a connection to the BX982 the port configured will turn 

green as shown below: 

 

 
 

Figure 3.23 ς BX982: Connected TCP/IP port 
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3.6. MODULE DOWNLOAD  
 

Once the XPosition configuration has been completed, it must be downloaded to the module. 

Before downloading the Connection Path of the module should be set. This path will 

automatically default to the IP address of the module, as set in the module configuration. It 

can however be modified, if the XPosition is not on a local network. 

The Connection path can be set by right-clicking on the module and selecting the Connection 

Path option. 

 

Figure 3.17. - Selecting Connection Path 

 

The new connection path can then be either entered manually or selected by means of the 

Target Browser. 

 

Figure 3.18. - Connection Path 

To initiate the download, right-click on the module and select the Download option. 
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Figure 3.19. - Selecting Download 

 

Once complete, the user will be notified that the download was successful. 

 

Figure 3.20. - Successful download 

 

5ǳǊƛƴƎ ǘƘŜ ŘƻǿƴƭƻŀŘ ǇǊƻŎŜǎǎ ǘƘŜ ƳƻŘǳƭŜΩǎ ǘƛƳŜ ǿƛƭƭ ōŜ ŎƻƳǇŀǊŜŘ ǘƻ ǘƘŀǘ ƻŦ ǘƘŜ t/Ωǎ ǘƛƳŜΦ 

Should the difference be greater than 30 seconds, the user will be prompted to set the 

module time to that of the PC time. 

 

Figure 3.21. ς Setting module time 

 

The module time is used only for the event log. 

Within the Slate environment the module will be in the Online state, indicated by the green 

circle around the module. 
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The module is now configured and will start operating immediately.  

 

Figure 3.22. - Module online 
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3.7. RSLOGIX 5000 CONFIGURATION 
 

The XPosition module will need to be configured for EtherNet/IP communication before it will 

connect to a Logix controller. This is done by setting the mode to EtherNet/IP under the 

general configuration (as shown below): 

 

 
 

Figure 3.23. ς EtherNet/IP mode 

 

 

3.7.1. ADD MODULE TO I/O CONFIGURATION 
 

The module needs to ƻǇŜǊŀǘŜ ƛƴ ŀ [ƻƎƛȄ άƻǿƴŜŘέ mode. When the module operates in a Logix 

άƻǿƴŜŘέ ƳƻŘŜ ǘƘŜ XPosition will need to be added to the RSLogix 5000 I/O tree. The module 

will need to be added as a generic Ethernet module. This is done by right clicking on the 

Ethernet Bridge in the RSLogix 5000 and selecting New Module after which the ETHERNET-

MODULE is selected to be added as shown in the figure below.  

 

NOTE: See the next section for importing the configuration (L5X). 
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Figure 3.24 - Add a Generic Ethernet Module in RSLogix 5000 

 

The user must enter the IP address of the XPosition that will be used. The assembly instance 

and size must also be added for the input, output, and configuration in the connection 

parameters section. Below are the required connection parameters. 

 

Connection Parameter Assembly Instance Size 

Input 107 59 (32-bit) 

Output 124 7 (32-bit) 

Configuration 102 0 (8-bit) 

 

Table 3.3 - RSLogix class 1 connection parameters for the XPosition 

 

 
 

Figure 3.25 - RSLogix General module properties in RSLogix 5000 
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NOTE: The user will need to enter the exact connection parameters before the 

module will establish a class 1 connection with the Logix controller. 

 

Next the user needs to add the connection requested packet interval (RPI). This is the rate at 

which the input and output assemblies are exchanged. The recommended value is 200ms. 

Refer to the technical specification section in this document for further details on the limits 

of the RPI. 

 

NOTE: Although the module is capable of running with an RPI of 10ms, it is 

recommended to set the RPI to 200ms, to avoid unnecessary loading of the 

module processor. 

 

 
 

Figure 3.26 - Connection module properties in RSLogix 5000 

 

Once the module has been added to the RSLogix 5000 I/O tree the user must assign the User 

Defined Types (UDTs) to the input and output assemblies. The user can import the required 

UDTs by right-clicking on User-Defined sub-folder in the Data Types folder of the IO tree and 

selecting Import Data Type. The assemblies are then assigned to the UDTs with a ladder copy 

instruction (COP) as shown in the figure below.  

 

 
Figure 3.27 ς RSLogix 5000 I/O module tree 

3.7.2. IMPORTING UDTS AND MAPPING ROUTINES 
 

To simplify the mapping of the input image, an RSLogix 5000 Routine Partial Import (L5X) file 

is provided.  

 

This file can be imported by right-clicking on the required Program and selecting the Import 

Routine option. 
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Figure 3.28. ς RSLogix 5000 Importing XPosition specific routine and UDTs 

 

 
Figure 3.29. - Selecting partial import file 

 

The import will create the following: 

¶ The required UDTs (user defined data types) 

¶ Two controller tags representing the Input and Output assemblies. 

¶ A routine mapping the XPosition module to the aforementioned tags. 

 

The user may need to change the routine to map to the correct XPosition module instance 

ƴŀƳŜΣ ŀƴŘ ƳŀƪŜ ǎǳǊŜ ǘƘŀǘ ǘƘŜ ƳŀǇǇƛƴƎ ǊƻǳǘƛƴŜ ƛǎ ŎŀƭƭŜŘ ōȅ ǘƘŜ tǊƻƎǊŀƳΩǎ aŀƛƴ wƻǳǘƛƴŜΦ 
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Figure 3.30. - Imported RSLogix 5000 objects 

 

Refer to the additional information section of this document for an example RSLogix 5000 

project as well as the required UDTs. 

 

3.8. MODBUS TCP CONFIGURATION 
 

The XPosition module will need to be configured for Modbus TCP communication before a 

Modbus Master will be able to communicate with it (the XPosition module will operate as a 

Modbus Slave). This is done by setting the mode to Modbus TCP under the general 

configuration (as shown below). 

 

The user will also need to configure a Modbus Node address for the XPosition which will be 

used by the Modbus Master to communicate with the XPosition. 
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Figure 3.31. ς Modbus TCP mode 

 

 

 

  














































